
 
FINAL 

© 2012. All Rights Reserved. 
California State University, Bakersfield Last modified 10/12/2012 

 
 

Campus Solutions 9.0 

Class Schedule Audit 

Business Process Guide 

 

 



 
  

CS90 Audit/Review Class Schedules - BPG 
Last Modified by tsherman on 10/12/2012 

© 2012 All Rights Reserved. 
CSU Bakersfield 

Page 2  

 

 
Class Schedule Audit 

Campus Solutions 9.0 

Staff 
Business Process Guide 

REVISION CONTROL   

Document Title: CS90 Audit Review Class Schedules - BPG.docx 

Author: CMS PeopleSoft Training 

File Reference: H:/SA Training/Production/Documentation/SelfService/Staff 

Revision History  

Revision Date  Revised By Summary of Revisions Section(s) Revised 

9/28/12 T. Sherman Modified document All 

10/9/12 L. Flores Added section 3.20 Room Characteristics 3.20 

10/11/12 T. Sherman Modified sections  3.5, 3.8,3.13, and 

3.20 

10/11/12 T. Sherman Added section 2.4 Room Characteristics 2.4, 3.20 

Review / Approval History  

Review Date Reviewed By  Action  (Reviewed, Recommended or Approved) 

9/28/12 Lilia Flores Approved 

9/28/12 Paula Miser Approved 

 Laura Bishop  

9/28/12 Andrea Weikel Approved 

10/8/12 Beth Garza Approved 

 
  



 
  

CS90 Audit/Review Class Schedules - BPG 
Last Modified by tsherman on 10/12/2012 

© 2012 All Rights Reserved. 
CSU Bakersfield 

Page 3  

 

 
Class Schedule Audit 

Campus Solutions 9.0 

Staff 
Business Process Guide 

Table of Contents Page 

1.0 Overview ........................................................................................................................................................... 5 

1.1 Audit Process .......................................................................................................................................... 5 

1.2 Assumptions ............................................................................................................................................ 5 

2.0 Download Class Information ............................................................................................................................. 6 

2.1 Download Class Schedule Data ............................................................................................................. 6 

2.2 Download Instructor Table Data ............................................................................................................. 7 

2.3 Download Class Notes Data ................................................................................................................... 8 

2.4 Download Room Characteristics Data .................................................................................................... 9 

3.0 Audit Class Schedules .................................................................................................................................... 11 

3.1 Before you begin ................................................................................................................................... 11 

3.2 Sessions ................................................................................................................................................ 12 

3.3 Section Numbers ................................................................................................................................... 12 

3.4 Instruction Modes .................................................................................................................................. 13 

3.5 Associated Class Numbers ................................................................................................................... 14 

3.6 Component and Class Types ................................................................................................................ 15 

3.7 Auto Enrollment ..................................................................................................................................... 16 

3.8 Component Units .................................................................................................................................. 17 

3.9 Enrollment Capacity .............................................................................................................................. 18 

3.10 Location ................................................................................................................................................. 19 

3.11 Class Association Requisites ................................................................................................................ 20 

3.12 Catalog Requisites ................................................................................................................................ 21 

3.13 Minimum, Maximum, Academic Progress, FA Units, Course Contact Hours, and Contact ................. 22 

3.14 Space Type ........................................................................................................................................... 23 

3.15 Mtg Start and Mtg End Times ............................................................................................................... 24 

3.16 Class Notes ........................................................................................................................................... 26 

3.17 Instructor Assignment ........................................................................................................................... 27 

3.18 Instructor Assign Type .......................................................................................................................... 28 

3.19 Instructor Access ................................................................................................................................... 30 

3.20 Room Characteristics ............................................................................................................................ 30 

3.21 Textbook ............................................................................................................................................... 31 

4.0 Appendix ......................................................................................................................................................... 32 

4.1 CSUB Academic Programs ................................................................................................................... 32 



 
  

CS90 Audit/Review Class Schedules - BPG 
Last Modified by tsherman on 10/12/2012 

© 2012 All Rights Reserved. 
CSU Bakersfield 

Page 4  

 

 
Class Schedule Audit 

Campus Solutions 9.0 

Staff 
Business Process Guide 

4.1.1 Section Numbers  (effective Fall 2010) .................................................................................... 32 

4.1.2 Instruction Modes, Learning Mode, Location, Space Type, and Comments Table ................. 34 

4.1.3 Component Unit Breakdown .................................................................................................... 35 

4.2 Extended University Regional Programs .............................................................................................. 36 

4.2.1 Section Numbers (effective Summer 2012) ............................................................................. 36 

4.2.2 EUD Contract Credit Sections ................................................................................................. 36 

4.2.3 EUD Certificate/Extended Univ. sections ................................................................................ 36 

4.2.4 EUD Sections and Location Codes .......................................................................................... 37 

4.3 Getting Help .......................................................................................................................................... 38 

 



 
  

CS90 Audit/Review Class Schedules - BPG 
Last Modified by tsherman on 10/12/2012 

© 2012 All Rights Reserved. 
CSU Bakersfield 

Page 5  

 

 
Class Schedule Audit 

Campus Solutions 9.0 

Staff 
Business Process Guide 

1.0 Overview 

Before enrollment begins, it is important to audit your class schedules to ensure accuracy and to prevent 

problems with students enrolling in classes. You should audit all aspects of your class schedules, such as 

section numbers, component types, associated class numbers, meeting patterns, APDB values, etc. By 

auditing your classes, you help to ensure the accuracy and integrity of the ERSx and APDB reporting 

data. 

 

This guide provides general instructions for auditing your courses. The information in this guide does not 

override existing procedures for class audits, so be sure to refer to current documentation.  The aim of 

this document is to provide a framework for auditing your class schedules.  The Appendix contains copies 

of existing procedures for sections numbers, component types, and other information.  The Appendix 

information is as current as of this document date of creation.   

1.1 Audit Process 

The audit process involves two distinct parts: Download Class Information and Audit Classes. Figure 1 

illustrates the process for auditing class schedules 

  

 Download Class Information 

You will run three queries that contain your class information. You will download the information 

as Excel spreadsheets.  

 

 Audit classes 

You will use the downloaded spreadsheets to identify discrepancies with your classes. You will 

correct the specified errors using the appropriate myCSUB page, such as Maintain Schedule of 

Classes or Schedule of Class Meetings. 

 

 

 

 

 

 

 

 

 

 

 

1.2 Assumptions 

The general instructions herein assume that you are comfortable with: 

 

 Using myCSUB 

 Adding new and maintaining existing classes and schedules 

 

For more information on maintaining class schedules, please refer to the Schedule of Classes Quick 

Reference Guide.  

Audit 

Review Correct 

Class Info 

Instructor 
Info 

Class 
Notes 

Download 

Figure 1: Class Schedule Audit Process 
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2.0 Download Class Information 

In this section, you will download the results from three queries that contain information on your classes. 

The queries are: 

 

 BAKS_SR_Schedule 

Used to audit class schedules 

 BAKS_SR_Instructor_tbl 

Used to audit instructor assignment and workload 

 BAKS_SR_Class_Notes 

Used to audit your class notes 

2.1 Download Class Schedule Data 

These instructions will walk you through running the BAKS_SR_Schedule query and downloading the 
results to Excel. 
 

# Steps Illustrations 

1.  Navigate to the Reporting Tools > Query > Query Viewer   

2.  On the Query Viewer page,  

 Enter the search criteria, 

BAKS_SR_Schedule 

 Click .   
 

3.  From the Search Results page,  

 Click the Excel link beside the query named, BAKS_SR_SCHEDULE.  

(The query will open in a new tab or window. You can also click the Favorite link to add this query to 

your list of favorite queries.) 

 

 

4.  On the prompt page, BAKS_SR_SCHEDULE – 
Schedule Audit,  

 Enter the Term, such as 2128  

 Click  

 

5.  Depending on your browser and browser 
settings, a dialog box appears,  

 Follow the options on the screen to open the 

document in Excel. 
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6.  When Excel opens,  

 Click the File tab 

 Click Save As 

 

 

7.  When the Save As dialog appears, 

 Navigate to the appropriate directory or 

network drive 

 Give the file a meaningful name, such 2128 

Class Audit 

 Click  

 

2.2 Download Instructor Table Data 

These instructions will walk you through running the BAKS_SR_Instructor_tbl query and downloading 
the results to Excel. 
 

# Steps Illustrations 

1.  Navigate to the Reporting Tools > Query > Query 

Viewer  or return to the Query Viewer tab by clicking 

the appropriate tab on your web browser. 

 

2.  On the Query Viewer page,  

 Enter the search criteria, BAKS_SR_Instructor_tbl  

 Click  

 

3.  From the Search Results page,  

 Click the Excel link beside the query named, BAKS_SR_Instructor_tbl 

(The query will open in a new tab or window. You can also click the Favorite link to add this query to 
your list of favorite queries.) 
 

 

4.  On the prompt page, BAKS_SR_INSTRUCTOR_TBL -  
Instructor Information,  

 Enter the Term, such as 2128  

 Click  
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5.  Depending on your browser and browser settings, a 
dialog box appears,  

 Select the option to open the file with Microsoft 

Excel. 

 Click OK, if appropriate 

 

6.  When Excel opens,  

 Click the File tab 

 Click Save As 

 

 

7.  When the Save As dialog appears, 

 Navigate to the appropriate directory or network 

drive 

 Give the file a meaningful name, such 2128 

Instructor Info 

 Click  

 

2.3 Download Class Notes Data 

These instructions will walk you through running the BAKS_SR_CLASS_NOTES query and 
downloading the results to Excel. 
 

# Steps Illustrations 

1.  Navigate to the Reporting Tools > Query > Query 

Viewer  or return to the Query Viewer tab by clicking 

the appropriate tab on your web browser. 

 

2.  On the prompt page, BAKS_SR_CLASS_NOTES – 
Notes by term and subject,  

 Enter the Subject, such as BIOL 

 Enter the Term, such as 2128  

 Click  
 

3.  Depending on your browser and browser settings, a 
dialog box appears,  

 Select the option to open the file with Microsoft 

Excel. 

 Click OK, if appropriate 
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4.  When Excel opens,  

 Click the File tab 

 Click Save As 

  

5.  When the Save As dialog appears, 

 Navigate to the appropriate directory or network 

drive 

 Give the file a meaningful name, such 2128 Class 

Notes 

 Click  

 

2.4 Download Room Characteristics Data 

These instructions will walk you through running the Class Info by Subject query and downloading the 
results to Excel. 
 

# Steps Illustrations 

1.  Navigate to the CSUB Query Dashboard  

 

2.  When the page opens, click the Class Info by 

Subject link in the Faculty Queries section. 

 

3.  On the prompt page, BAKS_SR_CRSE_BY_SUBJ,  

 Enter the Term, such as 2131 

 Enter the Subject, such as PSYC 

 Click  

 

4.  After your results display, click the Excel SpreadSheet 
link.  
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5.  Depending on your browser and browser settings, a 
dialog box appears,  

 Select the option to open the file with Microsoft 

Excel. 

 Click OK, if appropriate 
 

6.  When Excel opens,  

 Click the File tab 

 Click Save As 

  

7.  When the Save As dialog appears, 

 Navigate to the appropriate directory or network 

drive 

 Give the file a meaningful name, such 2131 Room 

Char 

 Click  
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3.0 Audit Class Schedules 

In this section, you will audit various aspects of your class schedules. Remember, the instructions herein 
are general, not intended to be exhaustive, and do not cover every situation. If you are unsure how to 
handle a situation, please feel free to contact Academic Scheduling at x3100. 

3.1 Before you begin 

You will need to open the spreadsheet from the Download Class Schedule Data section on page 6. 

1.  To open the previously saved spreadsheet from 
Download Class Schedule Data on page 6, 

 Click the File tab 

 Click Recent or Open 

 Double-click the file you saved earlier, such as 

2128 Class Audit 
 

2.  When the spreadsheet opens, you will see all the classes offered for that term enabling you to review and 
edit your course information.   
 

 Highlight the header row (Row 2). 
 

 

3.  In the Editing group of your ribbon, click Sort & Filter. 

 

 

4.  From the drop-down menu, select Filter. Arrows will 
appear beside each column header allowing you to 
select the type of data to display.  

 

5.  To view only the information for your subject area, 

 Click the Subject arrow 

 Uncheck the (Select All) 

 Check your subject area 

 Click OK  

6.  Now you are looking at just your classes. 
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3.2 Sessions  

You will need to ensure that you are only reviewing sessions (column B) for your campus, such as 1 for 

main campus/BKFLD and 10W for Extended University. 

1.  To audit your Session numbers,  

 Click the Session arrow in (Column B) of the 

spreadsheet 

 Make sure your Session numbers are either 1 for 

main campus/BKFLD and 10W for Extended 

University 

 

3.3 Section Numbers 

In this section, you will use the spreadsheet to review and identify errors with your section numbers. 

Table 1 provides the rules for formatting section numbers.   

Table 1: Section Numbers, page 30 

 

2.  To audit your Section numbers,  

 Click the Section arrow in (Column G) of the 

spreadsheet  

 Review your Section numbers for proper length and 

composition by scrolling through the numbers on 

the drop-down menu.  

3.  If you find an error with a Section Number,  go to 
Maintain Schedule of Classes, 

 Click the Basic Data tab 

 In the Class Section, enter the correct class 

section number, such as 01 

 Click   

 

 

Section 
numbers 

Proper length and Composition 

01, 40, etc  Section numbers must be two digits in length, such as 01, 02, 30 or 40.  

 You must add leading zeroes to ensure the section numbers are 

composed of two digits.   

 See the Appendix for more information on Section Numbers.  
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3.4 Instruction Modes 

In this section, you will compare the Section numbers to the Instruction Modes and make sure they 

match appropriately. The table below shows a partial list of appropriate Instruction Modes for specific 

Section numbers. 

Section 
Numbers 

Locations Description Instruction 
Modes 

Instruction 
Mode 

01 - 29 BKSFLD Face to Face P 

30 - 39 AV Face to Face P 

40 - 44 BKSFLD Independent Study IS 

45 – 49 AV Independent Study IS 

50 – 54 BKSFLD Instructional Television TV 

55 – 59 AV Instructional Television TV 

60 – 64 BKSFLD only Online   OL or HY 

65 - 69 AV only Online OL or HY 

70 – 74 BKSFLD Shared Online OL or HY 

75 – 79  AV Shared Online OL or HY 

80 - 99    

Table 2- Section Numbers and Instruction Modes 

1.  To audit your Section numbers and Instruction Modes,  

 Click the Mode arrow (column V) to select a mode 

to review.  

 

 

2.  For each mode in the drop-down menu, verify that your Section 

Numbers (Column G) reflect the appropriate Modes (Column V), 

use  

Table 2, to assist you. 

 

 

 See the Appendix for 

more information on 

section numbers and 

instruction modes 

3.  If you find an error with the Instruction Mode,  go to 
Maintain Schedule of Classes, 

 Click the Basic Data tab 

 In the Instruction Mode, enter the correct 

instruction mode, such as P  

 Click   
 

 See the Appendix for 

more information on 

section numbers and 

instruction modes 
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3.5 Associated Class Numbers 

In this section, you will compare the Section numbers and the Associated Class numbers and make 

sure they match appropriately.  In most instances, the Associated Class Number will be the same as 

the Class section number. For example if the Section number is 01, then the Associated Class Number 

will be 1. For Associated Class Numbers, the system removes the leading zeroes.  

Table 3: Example - Section numbers and Associated Class numbers is an example of sections and 

associated class numbers, for complete a complete list see the Appendix. 

 

 

 

 

 

 

 

 
Table 3: Example - Section numbers and Associated Class numbers 

 

 
The associated class number is the only number you see when you are adjusting units or 
setting enrollment requirement groups (requisites) through the Adjust Class Associations 
menu, therefore it is important that you assign it correctly. Once enrollment begins, you 
cannot change the Associated Class Number; the system will gray it out.  
 
Also, you can use Associated Class Numbers to link courses with one lecture and many 
labs/activities. For example, Biology offers one lecture (Associated Class Number = 1) and 
three labs (all three labs will have the same Associated Class Number = 1). By linking the 
courses, the students are prompted to select a lab section or a related class at registration.  

 

1.  To audit your Associated Class (column K) and 

Section numbers (Column G),  

 Click the Assoc arrow (column K).  

 

2.  For each mode in the drop-down menu, verify that your Section Numbers (Column G) reflect the 

appropriate  Assoc (Column K), use  

Table 3, to assist you. 

 

 

3.  Once enrollment begins, you cannot change the Associated Class Number; the system will gray 
it out. If you choose to change, you will need to remove the students from class, fix the 
associated class number, save it, and re-add the students. Otherwise, you can leave it as is, 
since it is not reported by Institutional Research Planning and Assessment (IRPA). 

Section Number 
(Column G) 

Component 
Corresponding Associated Class Number 

(Column K) 

01  Lect 1 

02  Lab 1 

03  Lab 1 

04  Lab 1 

30  Lect 30 

31  Lect 31 
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4.  If you need to change the Associated Class 
number,  go to Maintain Schedule of Classes, 

 Click the Basic Data tab 

 In the Associated Class, enter the correct 

associated class number, such as 1 

 Click   
 

3.6 Component and Class Types 

You will need to audit each class for proper Component and Class Type combinations. You should set 

the enrollment class type for lectures (graded component) to E and the enrollment class type for lab 

and activity components (non-graded component) to non-enrollment, N. 

 

For single component courses, you will always use Class Type of E. However, if you have a two-

component course, then you will use Class Type of E for the graded component and Class Type of N 

for non-graded component.  

 

Component Class Type When to Use 

LEC, SEM, IND E (enrollment) Graded components, such as lectures, 
seminar, activity, etc. 

LAB, ACT, etc. N (non-enrollment) Non-graded components, such as labs and 
activities 

Table 4: Components and Class Types 

 

1.  To audit your Component and Class Type,  

 Click the Component arrow (column H) to select a 

component to review, such as LEC.  

 

 

2.  For each mode in the drop-down menu, verify that 

your Component (Column H) reflects the 

appropriate Class Types (Column I), use Table 4: 

Components and Class Types, to assist you. 
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3.  If you find an error with the Class Type,  go to 
Maintain Schedule of Classes, 

 Click the Basic Data tab 

 In the Class Type, enter the correct class type, 

such as Enrollment 

 Click   

 

3.7 Auto Enrollment  

You will need to review the auto enrollments for missing entries. If you have two component courses, 

with one lecture and one lab or activity, you must connect the courses with auto enroll.  

When offering a Lecture section and a Lab section for a two-component class, such as CMPS 215 and 

216, you must connect the sections so that when the student enrolls for the Lecture, the system will 

enroll the student in the Lab section automatically.     

 

 

If your auto enroll is not setup correctly, then when the student tries to enroll or someone 
tries to quick enroll, they will receive the following message, “A required related class 
component lab must be selected. There is an additional component required for 
enrollment that is missing.” 

 

1.  To audit your Auto Enrollment,  

 Click the Catalog arrow (column D) to select the 

catalog number to review, such as 221.  

 

 

2.  In the Auto Enrol (column J), make sure you enter the section number to be auto enrolled, such as 002. 

 

 
 

When the student enrolls in the Biology Lecture component (Section 01), the student will be 

enrolled in the Lab component (Section 02), as well without having to enroll in it separately. 
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3.  If you need to add auto enrollment for a class,  go to 
Maintain Schedule of Classes, 

 Click the Enrollment Cntrl tab 

 In the 1
st

 Auto Enroll Section, enter the Class 

Section of the desired component, such as 02 

 Click   

 

3.8 Component Units 

You will need to review the Component Units for correct values. You must make sure that no zeroes(0) 

appear in the Comp Units column (column P) when an enrollment exists.  

 

1.  To audit your Component Units,  

 Click the Comp Units arrow (column P) to select 

the component units, such as 0.00.  

 

 

2.  In the Comp Units (column P), make sure no zeroes (0) exist. If they do, you will need to enter a value for 

the Component Units for the class components.  
 

 

 

Note:  
For two component courses, such as BIOL 100 the component units for lecture will be 4.00 and  
on the laboratory use 1.00 for the component units. (For more information, see 4.1.3 Component 
Unit Breakdown on page 35). 
 
You will need to check with your Dean or Department Chair before making changes, since 
it can affect the faculty’s WTUs and possibly their pay. 
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3.  If you need to add or update Component Units,  go to 
Maintain Schedule of Classes, 

 Click the Meetings tab 

 Click the Class APDB Mapping values link 

 

4.  When the APDB Class Section Values page opens, 

 In the Component Units, enter the component 

units, such as 4.00 

 Click  

 Click   
 

5.  
 

 

Note: For two component courses, such as BIOL 100 the component units for lecture will 
be 4.00 and  on the laboratory use 1.00 for the component units. (For more information, 
see 4.1.3 Component Unit Breakdown on page 35). 

 

3.9 Enrollment Capacity 

You will need to review the enrollment capacity and make sure it is not set zero (0). If the enrollment 
capacity is set to zero, the class will not appear when searching; and the system will flag the class as a 
closed section.  
 

 

When creating a new course, the enrollment capacity will automatically default to an 
enrollment capacity of 30. 

 

1.  To audit your Enrollment Capacity,  

 Click the Cap Enrl arrow (column S) to 

find classes with cap enrollment set to 0.  

 

 

2.  In the Cap Enrl (column S), make sure no zeroes (0) exist. If they do, you will need to enter a value for the 

enrollment capacity for the class. 
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3.10 Location 

You will need to verify that your section numbers reflect the appropriate location. Section numbers tell 
you where a class is located.  
 
For example, classes with section numbers between 01 and 29 and 40-44, 50-54, 60-64, 70-74, 80-99 
will have BKSFLD as their location.  Classes with section numbers between 30 and 39, 45-49, 55-59, 
65-69,75-79 will have AV as their location. Please refer to Table 2- Section Numbers and Instruction 
Modes on page 13 or the Appendix at the end of this document. 
 

1.  To audit your Bakersfield section numbers and 
location, 
 

 Click on Location (column U) 

 Select BKSFLD  

 

 

2.  Make certain your section numbers (column G) correspond to the location (column U) for 
BKSFLD. 
 

 

3.  To audit your Antelope Valley section numbers and 
location, 

 Click on Location (column U) 

 Select AV 

 

4.  Make certain your Section numbers (column G) correspond with the Location (column U) for AV 
 

 

3.  If you need to enter the enrollment capacity for a 
class,  go to Maintain Schedule of Classes, 

 Click the Enrollment Cntrl tab 

 In the Enrollment Capacity, enter a value, such as 

120 

 Click   
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5.  If you need to update a location for a class,  go to 
Maintain Schedule of Classes, 

 Click the Basic Data tab 

 In the Location, enter the location, such as 

BKSFLD or use the  to lookup the correct value 

 Click   

 

3.11 Class Association Requisites 

You will need to check your requirement groups for class association requisites. This requirement group 

is used for campus restrictions. You will review each class for missing and valid campus restrictions.  

See Table 5: Campus Restrictions by Location for a list of common campus restrictions. 

Location Campus Restriction Requirement Group 

AV AV Campus 000008 

BKSFLD Main Campus 000007 

AV or BKSFLD Honors 000021 

Table 5: Campus Restrictions by Location (partial list) 

 

1.  To audit your Requirement Group for Class 

Association Requisites for missing or incorrect 

entries,  

 Click the Location (column U) down arrow 

 Select a location, such as BKSFLD 

 

 
 

2.  In the RQ Group (column AE) make sure the values are correct and there are no missing entries. Table 5: 

Campus Restrictions by Location. 
 

 

3.  If you need to add or update the Requirement Group 
for Class Association Requisites for a class,  go to 
Adjust Class Association, 

 Click the Class Requisites tab 
 

4.  When the page opens, using the Class Association Requisites section: 

 In the Requirement Group, enter the correct value, such as 000007 or use the  to look up the 

appropriate value. 
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 Click   

 

 

3.12 Catalog Requisites  

You will need to check your requirement groups for catalog requisites. If a number, such as 000857, 

appears in the Rq Group (column AF), it means that the class has a requisite. Conversely, if the Rq 

Group (column AF) is blank, it indicates that the class has no requisites associated with it.  

 

1.  To audit your Requirement Group for Catalog 

Requisite ,  

 Click the Rq Group (column AF) down arrow 

 

Blanks indicate that the class may not have a 

requisite. 

 

2.  If you need to add or change a requisite, you must submit a request for approval New Course/Course 
Change from or contact Lilia Flores (x-3100). 
 
Link to form: 

http://www.csub.edu/academicprograms/Documents/Acadmeic%20Scheduling/newcourseapprovalchan
ge.xls  

3.  If you need to review the Requirement Group for 
Class Association Requisites for a class,  go to Adjust 
Class Association, 

 Click the Class Requisites tab 
 

4.  When the page opens, you will see the following in the Catalog Requisite section. Click the Detail link for 
the requisite detail and parameters. 

 

 

5.  The Enrollment Requisite Summary page appears. 
 

http://www.csub.edu/academicprograms/Documents/Acadmeic%20Scheduling/newcourseapprovalchange.xls
http://www.csub.edu/academicprograms/Documents/Acadmeic%20Scheduling/newcourseapprovalchange.xls
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3.13 Minimum, Maximum, Academic Progress, FA Units, Course Contact Hours, 
and Contact 

You must review the Minimum Units, Maximum Units, Academic Progress Units, FA Units, Course 

Contact Hours, and Contact for your classes. The system populates these fields by default.  However, 

the units listed in Minimum, Maximum, Academic Progress, FA Units, Course Contact, and Contact 

must be the same and should not have variable units, such as 1-5. If they are not the same, when the 

students register, the system will offer a range in units to them. If the students do not select the number 

of units, then the system will enroll them in the minimum units available.  

 

 

 

 

 

1.  To audit your Minimum, Maximum, Academic 

Progress, FA Units, Crs Cntct, and Contact 

 Click the Comp Unit arrow (column P) to select the 

component you desire to audit, such as 0.00 or 

1.00. 
 

2.  In the Min Units (column X), Max Units (column Y), Prgrss Unt (column Z), FA Units (column AA), Crs 
Cntct (column AB), and Contact (column AC) make sure the values are the same as Comp Units (column 

P) and there are no missing entries.  
 

 

Course 

Units 

Minimum 

Units 

Maximum 

Units 

Academic 

Progress Units 

FA Units Course 

Contact 

Contact 

1 1 1 1 1 1 1 

2 2 2 2 2 2 2 

3 3 3 3 3 3 3 

4 4 4 4 4 4 4 

5 5 5 5 5 5 5 
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3.  If you need to add or update the Minimum, Maximum, 

Academic Progress, FA Units,  and  Course Contact Hours 

for a class,   

 Go to Adjust Class Association  

 Click the Class Associations tab 

 In the Minimum Units, enter the correct value, 

such as 5.00 

 In the Maximum Units, enter the correct value, 

such as 5.00 

 In the Academic Progress Units, enter the correct 

value, such as 5.00 

 In the FA Units, enter the correct value, such as 

5.00 

 In the Course Contact Hours, enter the correct 

value, such as 5.00 

 Click   

 

4.  If you need to add or update the Contact for a class,   

 Click the Class Components tab 

 In the Contact, enter the correct value, such as 

5.00 

  

3.14 Space Type 

You will need to review the Space Type for correct and missing entries. The Space Type (Col Q) should 

contain a value between 1 and 4.  

 

Space type is updated through a Learn Mode Sync up process, for the most part this data will be 

populated automatically. For the occasional missing space type, you will need to review missing entries. 

The space type column Q should contain a value between 1 and 4.  

 

1.  To audit your Space Type,  

 Click the Space Type arrow (column Q) to select 

the space type you desire to audit, such as 1, or 

Blanks.  

 

Blanks indicate that the Space Type entries are 

missing. By filtering on Blanks, you can quickly 

identify classes that need updating.  

2.  In the Space Type (column Q), make sure the values are between 1 and 4 and there are no missing 

entries. 
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If you add a new class based on an Instruction mode, a nightly batch job, Learn Mode Sync, up 

process will populate the space type, learning mode, and location. However if you notice that the 

Space Type is missing and you did not recently add the class, then you will need to update it. 

3.  If you need to add or update the Space Type for a 
class,  go to Maintain Schedule of Classes, 

 Click the Meetings tab 

 Click the Meeting APDB Mapping values link  

 

 

4.  When the APDB Class Section Values page opens, 

 In the Space Type, select the appropriate value, 

such as 3 Non-Capacity 

 Click  

 Click   

 

3.15 Mtg Start and Mtg End Times 

You will need to review the times for meeting start and meeting end. You are strongly encouraged to 

not crossover time blocks when assigning meeting times, especially for class start times: 10am, 

12:45pm, and 7:30pm. (GE classes should not cross) 

 

Additionally, you will need to make sure you used correct am/pm designations, such as 4:15pm instead 

of 4:15am. Using military time can help reduce these types of errors. To use military time simply add 12 

to any time after 12:59pm, i.e. 1:00pm becomes 13:00.   

1.  To audit your Mtg Start and Mtg End times,  

 Click the Mtg Start (column AJ) arrow to select 

the times, such as 08:00:00 AM and 10:00:00 AM 
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2.  In the Mtg Start (column AJ) and the Mtg End (column AK), make sure that the: 

 

 No missing entries (especially Face-toFace courses) 

 AM/PM designations are correct 

 Start time must have sufficient minutes based on the CS Number 

 End time should not cross over for 10am and 12:45pm time blocks 

 Courses with CS Numbers between 1-16 and 18-21 have day and times assigned 
 

For more information, please refer to PeopleSoft Components and CS #’s (see Lilia Flores) and Schematic of 
Preferred Time Block (see Analia Rodriguez). 

 

 

3.  If you need to correct the Mtg Start or Mtg End for a class,  go to Maintain Schedule of Classes, 

 Click the Meetings tab 

 In the Mtg Start, enter the start time, such as 8:00AM 

 In the Mtg End, enter the start time, such as 9:40AM 

 Click   

 
 

 
If you are correcting a class with a combined section, you will need to use the Schedule Class 
Meetings menu. See the instructions below. 

 

4.  If you need to correct the Mtg Start or Mtg End for a class with a combined section,  go to Schedule Class 
Meetings, 

 Click the Meetings tab 

 In the Mtg Start, enter the start time, such as 8:00AM 

 In the Mtg End, enter the start time, such as 9:40AM 

 Click   
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3.16 Class Notes 

You will need to check for spelling errors, missing, and incomplete class notes. If the Instruction mode 

is TV, OL, or HY, you must include class notes. Additionally, if the class requires specific material, field 

trips, lab fees, or other “approved” class fees, you must include this information in the class notes. 

 

You can use either the BAKS_SR_Class_Notes query (see instructions on page 8) or the 

BAKS_SR_Schedule query (see instructions on page 6). 

1.  To audit your Class Notes,  

 Click the Class Notes arrow (column AS) to select 

the sections to review, such as 01 and 02.  

 

 

2.  To open the previously saved spreadsheet from 2.1 
Download Class Schedule Data on page 6 or 2.3 
Download Class Notes Data on page 8, 

 Click the File tab 

 Click Recent 

 Double-click the file you saved earlier, such as 

2128 Class Notes or 2128 Class Audit 
 

3.  To check for spelling errors, 

 Click the Review tab 

 Click the        button 

 

4.  When the Spelling box appears,  

 In the Not in Dictionary, determine if the word is 

spelled correctly 

 If not, continue with the step below. Otherwise, click 

Add to Dictionary 

 
 

5.  If you need to add or update your Class Notes,  go to 
Maintain Schedule of Classes, 

 Click the Notes tab 

 Make the correction 

 Click   
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3.17 Instructor Assignment 

You will need to audit your classes to ensure that you assigned instructors to your classes. You will use 

the instructor data you downloaded earlier to perform this audit. 

1.  You will need to open the spreadsheet from the 2.2 Download Instructor Table Data section on page 7.  

2.  To open the previously saved spreadsheet, 

 Click the File tab 

 Click Recent or Open 

 Double-click the file you saved earlier, such as 

2128 Instructor Info 

 

3.  When the spreadsheet opens, you will see all the classes offered for that term enabling you to review and 
edit your courses.   
 

 Highlight the header row (Row 2). 

 

 

4.  In the Data tab, click Filter. Arrows will appear beside 
each column header allowing you to select the type of 
data to display. 

 

 

5.  To view only the information for your subject area, 

 Click the Subject arrow 

 Uncheck the (Select All) 

 Check your subject area 

 Click OK  

6.  To audit for unassigned instructors ,  

 Check the Name (column H) down arrow 

 Unclick Select All 

 Click Blanks 

 Click OK  

 

7.  In the Name (column H) make sure you have 
assigned instructors to your classes. You must not 
leave this information blank. 
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8.  If you need to assign instructors to a class, go to Maintain Schedule of Classes, (update pic) 

 Click the Meetings tab 

 In the Instructor for Meeting Pattern section,  

- Click the Assignment tab 

- Enter the ID of the instructor, such as 099999999 or use the  icon to search for the instructor 

-  Select Approve as the Access 

 Click   

 

9.  You will need to add the load factor for the instructor, as well. In the Instructors for Meeting Pattern 

section,  

 Click the Workload tab 

 In the Load Factor, enter the correct amount, such as 100.0000 (if you have more than one faculty 

member assigned to a course, you will need to adjust the Load Factor based on their hiring contract. If 

you do not need the hiring contract details, see your department administration). 

 Click   

 

 

For combined sections classes and some independent studies, the Load Factor will appear as 

0.0000 and may have a Workload of 0.0000. For multiple faculty assignment, the Load Factor 

may appear as 1.0000 or 17.0000 or 25.0000, or 50.0000. These numbers will depend on the 

faculty load and should have a value higher than 0.0000. 
 

3.18 Instructor Assign Type 

You will need to audit your classes to ensure that you have not assigned an instructor to more than one 

meeting pattern at once. You will use the instructor data you downloaded earlier to perform this audit. 

1.  You will need to open the spreadsheet from the 2.2 Download Instructor Table Data section on page 7.  

2.  To open the previously saved spreadsheet, 

 Click the File tab 

 Click Recent or Open 

 Double-click the file you saved earlier, such as 

2128 Instructor Info 

 

3.  When the spreadsheet opens, you will see all the classes offered for that term enabling you to review and 
edit your courses.   
 

 Highlight the header row (Row 2). 
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4.  In the Data tab, click Filter. Arrows will appear beside 
each column header allowing you to select the type of 
data to display. 

 

 

5.  To view only the information for your subject area, 

 Click the Subject arrow 

 Uncheck the (Select All) 

 Check your subject area 

 Click OK  

6.  You will need to make sure the Assign Type (column O) is correct. It should show IFF by default. If NON is 
displayed, it indicates the Faculty member is assigned to more than once to a meeting 

 

 

7.  If you need to correct the Assign Type, go to Maintain Schedule of Classes, (update pic) 

 Click the Meetings tab 

 Click the View All in the Meeting Pattern section 

 

8.  You will need to: 

 Click the  to remove the instructor from the second meeting pattern. 

 Click   
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3.19 Instructor Access 

You will need to audit your classes to ensure that you set the access for your instructors to approve. 

You will use the instructor data you downloaded earlier to perform this audit. 

1.  You will need to use the spreadsheet from the 2.2 Download Instructor Table Data section on page 7.  

 See 3.17 Instructor Assignment on page 27, for instructions on how to open the previously saved 

spreadsheet.  

 If you need to download this data again, please refer to 2.2 Download Instructor Table Data on page 7. 

2.  To audit your instructors’ access ,  

 Click the Access (column J) down arrow 

 Unclick Select All 

 Click Blanks 

 Click OK  

 

3.  In the Access (column J) make sure you see the letter A for all your classes. You must not leave 
this information blank. 
 

 

4.  If you need to update the your instructor’s access,  go to Schedule Class Meetings, 

 Click the Meetings tab 

 In the Instructor for Meeting Pattern section, click the Assignment tab 

 Select Approve as the Access 

 Click   

 

3.20 Room Characteristics 

As of Winter 2013, Academic Scheduling will use the class scheduling software (R25) to assign courses 

to rooms.  An advantage of this software is that it uses the information about special room requests. To 

enable this process, you must enter these requests into PeopleSoft as you create your courses.   

 

In the past, Academic Scheduling would send out quarterly notices asking you for your special 

requests. Academic Scheduling will not send out the quarterly notices anymore, beginning Winter 

2013. Please contact Academic Scheduling if you have any questions. 

 

Room Characteristics  

Room 
Characteristics 

Description 



 
  

CS90 Audit/Review Class Schedules - BPG 
Last Modified by tsherman on 10/12/2012 

© 2012 All Rights Reserved. 
CSU Bakersfield 

Page 31  

 

 
Class Schedule Audit 

Campus Solutions 9.0 

Staff 
Business Process Guide 

(Leave blank) No room is required 

08 Computer Lab - Mac 

09 Computer Lab - PC 

19 ITV Studio 

31 Smart Classrm MAC 

32 Smart Classrm PC 

 

You will need to audit your classes to ensure the appropriate room characteristic is selected. You will 

have a choice of five (5) characteristics, please indicate which is required for each class.  If none 

required, leave the field blank.   

1.  You will need to use the spreadsheet from the 2.4 Download Room Characteristics Data on page 9. 

2.  To audit your room characteristics , verify that the 

Room Characteristics are appropriate for your 

classes. 

 Click the Room Char (column AG) down arrow 

to filter, if desired 
 

3.  If you need to enter or update your room characteristics, go to Maintain Schedule of Classes, 

 Click the Meetings tab 

 In the Room Characteristics section, click the  icon 

 Select the appropriate Room Characteristic from the Search Results, such as 32 

 Click   

 

3.21 Textbook 

Effective Summer 2012 Schedulers/Administrative Coordinators are no longer required to enter 

textbook information in PeopleSoft. Please disregard the textbook tab and textbook query in PS and if 

you roll classes forward from previous term do not roll over textbooks information. 

 

The textbook order is placed with the Follett Bookstore directly either by Faculty or 

Scheduler/Administrative Coordinator that depends on your departments business process.    
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4.0 Appendix 

4.1 CSUB Academic Programs 

The following sub-sections contain the section numbers and location codes for the different academic 

program offerings 

 

4.1.1 Section Numbers  (effective Fall 2010) 

The section numbers vary by a number of factors, such as program, Instruction mode, etc. 

    Section #’s Description 
Instruction 

Mode 
Notes 

01 - 29 BKFLD – warm body 

P  Requires Facility ID, day, and time 

30 - 39 AV – warm body 
P  Requires Facility ID, day, and time 

40 - 44 BKFLD – Independent Study 
IS  Consult with your AAS regarding 

workload 

45 – 49 AV – Independent Study 
IS  Consult with your AAS regarding 

workload 

50 – 54 BKFLD - ITV 

TV  Requires Facility ID, day, and time 

 Requires split workload with 55-59 

55 – 59 AV - ITV 

TV  Requires Facility ID, day, and time 

 Requires split workload with 50-54 

60 – 64 BKFLD only – Online   

OL or HY  For OL only, assign WEB as Facility 

ID,  

 For HY setup, follow step 3 below  

65 - 69 AV only – Online 

OL or HY  For OL only, assign WEB as Facility 

ID,  

 For HY setup, follow step 3 below 

70 – 74 BKFLD – shared Online 

OL or HY  For OL only, assign WEB as Facility 

ID,  

 For HY setup, follow step 3 below 

 Requires split workload with 75-79 
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75 – 79  AV – shared Online 

OL or HY  For OL only, assign WEB as Facility 

ID,  

 For HY setup, follow step 3 below 

 Requires split workload with 70-74 

80 - 99    Use sections as needed 

 

BKFLD and AV sections above use Session 1 

 

1. If an on-line course offering is designed as a separate or individual course, schedulers will use 

sections 60-64 for BKFLD and 65-69 for AV campus. Such sections will have their own instructor, 

their own enrollment cap, their own meeting pattern, etc. 

 

2. If an on-line course offering is designed as a shared course, schedulers will use sections 70-74 for 

BKFLD and 75-79 for AV campus. Departments can set up such pairs so that each offering has its 

shared enrollment cap. 

 

3. Use the on-line section numbers for the Hybrid courses, the HY course requires two meeting patterns 

in the following order: facility ID assignment for face to face and a second meeting pattern for the 

facility ID assignment of WEB, remove faculty assignment. 
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4.1.2 Instruction Modes, Learning Mode, Location, Space Type, and Comments Table 

The information is as follows: 

Instructio
n Mode 

CS#/Class 
APDB 

Mapping 
Value 

Learning Mode Location Space Type Comments 

TV 01, 02, 03, 
04, 05, 06 

S  
(synchronous) 

ITV courses 
(not conducted 

face to face) 

H 1-Lecture Use ITV section 
numbers 

TV 07, 08, 09, 
10, 11, 12, 
13, 14, 15, 
16, 17, 18, 
19, 20, 21 

S  
(synchronous) 

ITV courses 
(not conducted 

face to face) 

H 2-Laboratory Use ITV section 
numbers 

OL  01 - 48  A 
(asynchronous) 

Pure WEB and 
on-line courses 

(not face to 
face) 

blank 3-Non Capacity Use Web/On-
Line section 
numbers 

HY  01 - 48  A 
(asynchronous) 

WEB and on-
line courses 

with some face 
to face 

blank 4-Multi mode (a course will be 
defined as 
"hybrid" if any 
portion of the 
seat time of the 
course is 
replaced by 
online 
coursework) 
Use Web/On-
Line section 
numbers 

P 01, 02, 03, 
04, 05, 06 

F  
(face to face) 

Face to face 
courses 

(includes ind. 
study) and 
regularly 

conducted 
scheduled 
meetings 

blank 1-Lecture Use normal 
warm body 
section numbers 

P 07, 08, 09, 
10, 11, 12, 
13, 14, 15, 
16, 17, 18, 
19, 20, 21 

F  
(face to face) 

Face to face 
courses 

(includes ind. 
study) and 
regularly 

conducted 
scheduled 
meetings 

blank 2-Laboratory Use normal 
warm body 
section numbers 

P 17, 23, 24, 
25, 36, 48 

F  
(face to face) 

Face to face 
courses 

(includes ind. 
study) and 
regularly 

conducted 
scheduled 
meetings 

blank 3-Non Capacity Use normal 
warm body 
section numbers 

IS 01 - 78 F  
(face to face) 

Face to face 
courses 

(includes ind. 
study) and 
regularly 

conducted 

blank 3-Non Capacity Use 
Independent 
Study section 
numbers 
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4.1.3 Component Unit Breakdown  

The component breakdown can be found in the Course Catalog within the components tab, course 

components and CS number. There you can see how many components a class has and the break 

down per course component if more than one. 

 

Examples: 

 

CAFS 110 1 component course 2 units 2.0 component units 

Biol 100 2 component course 5 units 

(Lecture = 4.0 units, Lab 1.0 

units) 

5.0 component units 

(Lecture = 4.0 component units, 

Lab = 1.0 component units) 

Math 191 2 component course 5 units 

(Discussion = 2.5 units, Lecture 

2.5 units) 

5.0 component units 

(Discussion = 2.5 component 

units, Lecture 2.5 component 

units) 

 

  

scheduled 
meetings 

 move CS#17 
from Lab to 
Non-
Capacity 
space type 
effective 
09/01/12 
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4.2 Extended University Regional Programs 

The following sub-sections contain the section numbers and location codes for the different regional 
program offerings. All the EUD and Regional Program sections above use Session 10W. 

4.2.1 Section Numbers (effective Summer 2012) 

The section numbers for regional programs are listed in the table below. 
 

 Sections 101-114  for Face-to Face classes (normal warm body classes) 
 

Section Numbers for Regional Programs  

 

Program F2F Hybrid Online 

COMM (COC) 121-123 124 125 

Credential (COC) 141-143 144 145 

EDAD (Hanford) 181-183 184 185 

EDCI (OL) ~ ~ 166-170 

ENGL (COC) 149-151 152 153 

ERM (OL) ~ ~ 176-180 

LBST (COC) 115-118 119 120 

MPA (Lancaster) 146-147 148 149 

MSA (OL) ~ ~ 171-175 

SOC (COC) 153-154 155 156 

 

4.2.2 EUD Contract Credit Sections 

EUD Contract Credit sections - these sections will not require a classroom use only EUD as location 

code. 

 Sections 601 – 699 

4.2.3 EUD Certificate/Extended Univ. sections 

EUD Certificate/Extended Univ. sections - these sections will require classrooms, EBKS and EAVC 

location codes will be used for these sections. 

 Sections 701 – 728 Warm Body for Bakersfield and Open University 

 Sections 730 – 749  Independent Study 

 Sections 750 – 759  Warm Body for AVC 

 Sections 760 – 769 EUD (Bakersfield and AV) On-line/WebCt 
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4.2.4 EUD Sections and Location Codes 

EUD sections will use the following location codes: 

 
Code Location 

COC College of Canyons 

EUD Extended University (not requiring a room at main campus) 

EBKS Extended University (any class which requires a room assignment on main campus) 

EAVC Extended University (any class which requires a room assignment on AVC campus) 

HAN Hanford W. High School 

O Open University 

OLP On-line Programs 

PCC Porterville College 
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4.3 Getting Help 

If you are unsure or need assistance, please consider the preferred sources and order in which to 

contact listed below: 

 For help with auditing class schedules 
Lilia Flores – Academic Scheduling 
661-654-3100 
 

 For help with auditing class schedules for Extended University courses 
Beth Garza – Extended University 
661-654-2441 
 

 For help with computer-related Issues 
Help Desk 
661-654-2307 
 

 For help with Microsoft Excel 2010 
 
How to filter data in Excel 2010 
http://www.gcflearnfree.org/excel2010/13  

 
 

How to use Excel 2010 
http://www.gcflearnfree.org/excel2010  

 

 

http://www.gcflearnfree.org/excel2010/13
http://www.gcflearnfree.org/excel2010

